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1 General 

1.1 Information  

This manual describes the coatmaster and provides all information required for its safe operation and 
to maintain it in good working order.  

Read this manual carefully before installing and running your system and note the safety precautions 
in chapter 2 in particular. Store the manual in the immediate vicinity of the instrument, so that it can 
be consulted at any time.  
 
Figures in this manual serve the general understanding and might deviate from the actual product 
design. 

1.2 About this manual 

The User Manual contains instructions on proper installation, use of the coatmaster, safety infor-
mation, and user maintenance and trouble shooting. More detailed information on network and com-
munication setup, calibration, applications and external remote control are available in the Operator 
Manual. 

Paragraphs starting with NOTE transport helpful information for working with the device/software or 
its supplementaries. NOTE’s are not related to any kind of hazard or damage (see following example).  

NOTE  
Useful tips for the easy operation of the instrument/software. 
 

1.3 Liability limitation 

The device is designed and built in accordance with current state-of-the-art technology. Nevertheless, 
risks to users, property, and the environment can arise when the device is used carelessly or improp-
erly.  

coatmaster AG has determined the following residual dangers emanating from the device:  
• The Operator Manual is not considered. 
• The device is not operated according to its proper use.  
• The device is operated by insufficiently trained personnel.  
• Unauthorized modification of the device. 
• Use of unlisted spare parts 

 
Appropriate warnings in this manual serve to make the user alert to these residual dangers. 
 
Due to special designs, additional options are latest technical modifications, the actual scope of deliv-
ery might deviate from the descriptions and illustrations herein. 
 
The obligations agreed upon in the delivery contract, the General Terms and Conditions as well as 
the delivery conditions of the manufacturer and the legal provisions in effect at the time of contract 
closure shall be applicable. 
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Copyright 

No technical modifications may be made to the device without the prior written agreement of coat-
master AG. Unauthorized modifications may affect the system safety or result in accidents.  
 
This manual is copyright. Information from it may not be reproduced, distributed, or used for com-
petitive purposes, nor made available to third parties. The manufacture of any component with the 
aid of this manual without prior written agreement is also prohibited.  

1.4 Warranty conditions 

The warranty conditions are part of the General Terms and Conditions of the manufacturer. 
 
The software is installed on the embedded PC integrated in the coatmaster. Any system modification 
and modification of the embedded PC as e.g. 

• Installation of further software 
• Software updates 

can affect or damage the coatmaster and are are therefore prohibited. 
coatmaster AG assumes no liability for data loss on the embedded PC. It is suggested to regularly 
backup the data on the embedded PC (application and measurement data). 

1.5 Scope of delivery 

Scope of delivery of the coatmaster: 
• coatmaster 
• 230V mains cable 
• Operator’s Manual, User’s Manual, Service Book 

 
 
Scope of delivery of the coatmaster Inline: 

• coatmaster measurement head 
• CM cooling unit (19“ rack insert, 3 height units) 
• CM control unit (19“ rack insert, 3 height units) 
• 230V mains cable 
• Connecting cable between measurement head and CM Power Supply 
• Connecting cable between CM Power Supply and CM Water Supply 
• 2 coolant tubes between CM Water Supply and measurement head 
• Operator Manual, Service Book 
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2 Safety 

This section gives an overview of all relevant safety aspects for an optimal personal protection as 
well as for a save and undisturbed operation. 

2.1 Responsibility of the operator 

The operator is responsible for training his/her personnel.  

The operator shall inform the manufacturer without delay of any safety-related incidents which might 
occur during operation of the device or its accessories.  

Issues can be reported to the e-mail address: info@coatmaster.com  
Legal regulations, such as local, state and federal laws applying to the device or its accessories must 
be strictly followed.  

2.2 User qualification 

Before the use of the coatmaster the operation manual must be read and understood.  
The device may only be used by persons who on account of training or professional experience have 
an overview of the dangers which may arise when operating the device. 

2.3 Proper use 

The coatmaster is exclusively designed for measuring thicknesses of coatings. It can be used for the 
following coatings: 

• Powder coatings on metallic substrates 
• adhesive coatings on metallic substrates 
• polymer coatings on metallic substrates 
• wet paint on metallic substrates 
• wet paint (wet-state) on non-metallic substrates 
• thermal spray coatings. 

The device must only be operated and cleaned by trained personnel. The proper use also includes 
adherence to this manual. The service intervals have to be maintained. 

2.4 Improper use 

Use not mentioned above or use that does not comply with the technical specifications is considered 
improper use. The operator bears the sole risk for any damages caused by such improper use. The 
following uses are forbidden:  

• Use of the coatmaster in environments, where liquids can enter the housing. 
• Introduction of any objects into the coatmaster. 
• Opening the coatmaster’s housing. Exception: Cleaning or changing the filter pad (see chap-

ter 7). This is also valid when the coatmaster is not connected to the mains. When the coat-
masters is opened, the warranty is void and the manufacturer disclaims all liability. 

• If liquid leaks from the coatmaster, unplug the device immediately and contact technical sup-
port.  

mailto:info@coatmaster.com
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Technical support for the coatmaster +41 (0) 52 212 02 77, info@coatmaster.com  

2.5 Safety warnings and signals used in this manual 

2.5.1 Description of the safety warnings 

DANGER, WARNING, CAUTION and NOTICE are standardized signal words for identifying levels of 
hazard seriousness of risks related to personal injury and property damage. All signal words, which 
are related to personal injury are accompanied by the general safety sign.  

For your safety it is important to read and fully understand the below table with the different signal 
words and their definitions! 

Sign Signal word Definition Risk level 
 

 

DANGER Indicates a hazardous situation which, if not 
avoided, will result in death or serious injury.  
 

���� 

 

 

WARNING Indicates a hazardous situation which, if not 
avoided, could result in death or serious injury.  
 

��� 

 

 

CAUTION Indicates a hazardous situation which, if not 
avoided, may result in minor or moderate injury.  
 

�� 

 NOTICE Indicates possible property damage, but no prac-
tices related to personal injury.  

 

 
Supplementary safety information symbols may be placed in a rectangular panel on the left to the 
signal word and the supplementary text (see below example). 

 

 

 
DANGER 

Supplementary text, describing the hazard/risk (e.g. explosion). Result of the hazard 
if not avoided (e.g. death). 
1. List of measures to avoid the herein described hazard or harzardous situation. 

 

2.5.2 Used symbols 

The below reference list incorporates all safety information symbols used in this manual or on the 
device and their meaning. 

  

mailto:info@coatmaster.com
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Symbol Meaning 

 

General hazard 

 

Device damage 

 

Electrical hazard 

 

2.6 Product safety 

The device is designed and built in accordance with current state-of-the-art. Nevertheless, risks to us-
ers, property, and the environment can arise when the device is used carelessly or improperly.  

coatmaster AG has determined the following residual dangers emanating from the device:  
• The device is operated by insufficiently trained personnel.  
• The device is not operated according to its proper use. 

 
Appropriate warnings in this manual serve to make the user alert to these residual dangers. 
 
This device was built and tested in compliance with the safety requirements for electrical 
equipment for measurement, control and laboratory use IEC 61010-1 (2010) and the Low 
Voltage Directive 2014/35/EU.  
 
The device satisfies the EMC requirements for electrical equipment for measurement, con-
trol and laboratory use of the international standard IEC 61326-1 (2012). 
 
To ensure photobiological safety the device should be operated in accordance with the 
guidelines for the safe use of intense pulsed light source equipment on humans IEC 62471-3 
(2015). 
 

2.6.1 General hazards 

The following safety messages show hazards of general kind which may occur when handling the de-
vice. The user shall observe all listed counter measures in order to achieve and maintain the lowest 
possible level of hazard.  
Additional warning messages can be found whenever actions and situations described in this manual 
are related to situational hazards. 
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CAUTION 

Integrated light source. Direct visual contact can lead to visual impairment. 

Never look directly into the light source. 

For using the coatmaster within a process environment we recommend to build an optical 
cover around the light source, to absorb the light impulse, so that it will not have an impact be-
yond the measurement area. For this purpose e.g. blackened metal sheets might be used. 

 

2.6.2 Integrated safety elements 

A slow blow fuse of 12.5 A is integrated into the coatmaster as overvoltage protection. 
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3 coatmaster Hardware Interfaces 

3.1 coatmaster  

 
 

 
 
Figure 1. coatmaster 3D CAD illustration 
 
 
 
 

 
 
Figure 2 coatmaster frontal view (left) and side view (right) 
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Figure 3 coatmaster connections - Rear view 
1 ON/OFF push-button  
2 Power connection  
 

3 USB Connection for WIFI 
4 Ethernet connection  
5 Sensor connection  
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3.2 coatmaster Inline 

 
 

 
Figure 4. 3D CAD illustration of the coatmaster in-line measurement and sensor head 
 

  
Figure 5. Frontal (left) and side view (right) of the coatmaster in-line measurement and sensor head 
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Figure 6. coatmaster Inline - measurement optics rear view 

 

  

 
Figure 7. coatmaster Inline - Control (top) and Cooling (bottom) units 
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Figure 8. coatmaster Inline - Control (top) and Cooling (bottom) units - front view 

 
 

 
Figure 9. coatmaster Inline - Control (top) and Cooling (bottom) units  - rear view 
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4 System Installation 

NOTE 
Inspect the device for damages during unpacking. Accept damaged packages only under reservation 
of possible damage. Write this reservartion on the delivery note. Immediately inform the carrier and 
the sender and do not unpack the damaged package until notification of the sender. 

Keep the original packaging material for future transportation. 

4.1 Hardware installation 

• Put the device on a clean, stable, even and horizontal surface. Consider the maximum device 
dimensions, the weight and the operating conditions as described in chapter 3.1. 

• Do not place any objects on or under the device. 
• The device must have a distance of at least 20 cm to another object or the wall to guarantee 

a sufficient cooling. 
• Connect the device with the mains by means of the mains cable contained in the scope of 

delivery. 
 

 

 

 
WARNING 

Risk of burns by electric current. Serious injuries or death can result. 

Check for proper grounding before use. Replace defective cabling instantly.  
 

 
 

 

 
CAUTION 

Integrated light source. Direct visual contact can lead to visual impairment. 

Never look directly into the light source. 

For using the coatmaster within a process environment we recommend to build an optical 
shielding around the light source, to absorb the light impulse, so that it will not have an impact 
beyond the measurement area. For this purpose e.g. blackened metal sheets might be used. 

 

 
NOTE   
To cut the power in case of an emergency by unplugging, the devices or any other items must not 
block the mains plug! 

 

 

 
NOTICE 

Risk of false alarm of flame detectors. Incompatible flame detectors might be triggered 
wrongly by means of the coatmaster’s light impulse.  

For rooms where the coatmaster is operated, use compatible fire detectors with dual UV/IR 
sensors (e.g. from the company STS Brandschutzsysteme GmbH). 
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NOTICE 

Instrument damage by wrong installation. Installing the device with a wrong tilt angle may 
lead to device overheating. 

When installing the device vertically tilted, an angle of 30° must not be exceeded. When in-
stalling the device horizontally tilted, an angle of 90° must not be exceeded. 

 

 
 

 

 
NOTICE 

Risk of device error by fingerprints on the lense. Contaminations on the lense might lead to 
measurment errors. 

Never touch the lense directly. Clean the lens and measurement window as described in chap-
ter 7.2. 

 

 

4.2 Software requirements 

The coatmaster can be operated via three different software environments: 
 
coatmaster Operating System: Starting measurements, creating applications, exporting measure-
ment data, display measurement values and statistics. The creation of applications and the export of 
measurement data can only be done with the coatmaster Desktop. The software must be installed on 
a Windows-PC.  

System requirements: 

• Operating system: Windows 10, 64bit 
• Processor: 2.4 GHz 
• Working memory: 4 GB 
• Available harddisk memory: 300 MB 
• Display resolution: 1024 x 768 

coatmaster Web Client: Starting measurements, displaying measurement values, defining network- 
and administrator settings, installing software updates. The definition of network- and administrator 
settings, as well as the installation of software updates is only possible with the Web Client. 

System requirements: 

• Web-Browser  

Remote control: Measure over the TCP/IP-interface. This interface is used to trigger measurements 
and to transfer measurement values. Examples: PLC systems like Siemens S7 or Beckhoff TwinCAT. 
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Before you can measure with coatmaster Web Client or through the remote control, a corresponding 
application must be created with the coatmaster Desktop Software. This is described in chapter 5.7. 

4.3 Interface to connect with control computer 

To be able to operate the coatmaster, the computer must be connected with an Ethernet cable to 
the coatmaster. 
 

4.4 Network and administrator settings 

Make sure that the coatmaster is correctly installed as described in chapter 4.1 Hardware installation 
and switch it on. Proceed as follows to configure network and install software: 

1. Configure the coatmaster network access as described in chapter 4.4.1. 
2. Install the coatmaster Operating System at least on one Windows-computer as described in 

chapter 4.4.2. The coatmaster Operating System is needed to create coatmaster applications. 

4.4.1 Configuring coatmaster network with coatmaster Web Client 

Make sure the coatmaster and the operating computer are connected with an Ethernet cable. The IP 
address of the coatmaster is noted in the coatmaster Service Book, which is part of the scope of de-
livery. If you want to change the network configuration (IP address, net mask, gateway), proceed as 
follows: 
 

1. Open a web browser, enter the IP address of the coatmaster (e.g. “192.168.1.140”) in the 
URL field and confirm with Enter. 
The web browser now connects to the coatmaster and opens the main window of the coat-

master Web Client. If necessary, change the language with the -button on the top right. 

 

Figure 10. Web client start page 
 

2. Click the Administrator line and log in with the user admin and the password Welcome123.  
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3. In the network window the IP-address for the ethernet-connection, the WLAN-SSID (name) 
and the WLAN-password can be defined. The SSID can be hidden, if necessary. In this case, 
deactivate the checkbox On. Click on Save. Please note: subnet addresses 192.168.139.XXX 
and 109.198.7.XXX are not allowed.

 

Figure 11. Administrator settings in the web client 
 
Enter the data here to have them available for later use: 
 

coatmaster serial 
no.: 

 

WLAN SSID:  

WLAN-password:  

Ethernet IP-ad-
dress: 

 

 
 
If the login data is lost, please inform your administrator. After having changed the network settings, 
restart the coatmaster (switch off the main switch, wait for 10 seconds and switch on the device 
again).  
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4.4.2 Installing coatmaster Desktop Software 

Make sure the coatmaster and the operating computer are connected with an Ethernet cable. The IP 
address of the coatmaster is noted in the coatmaster Service Book, which is part of the scope of de-
livery. 

1. Open a web browser, enter the IP address of the coatmaster (e.g. “192.168.1.116”) in the 
URL field and confirm with Enter.  

 

Figure 12. Download window in the web client 
 

2. Click on Download. The Downloads submenu opens. Click on “coatmaster.Operating.Sys-
tem.18.1.Matterhon” to download the coatmaster Operating System software. The message 
Show all downloads is displayed in the browser window (position and wording depends on 
the web browser type). On a click on the text an overview of the latest downloads opens 
(view depends on the web browser type). 

3. Extract the content of the downloaded ZIP-file onto your computer (with right-click on the 
ZIP-file). The ZIP-file can be deleted afterwards. 

4. The extracted archive contains the folder coatmaster.Operating.System. 18.1.Matterhon 
with the executive file “coatmaster Operating System 18.exe”. Create a link from “coatmas-
ter Operating System 18.exe” and move it to the desktop so that it is easily accessible. 

5. Start the coatmaster Operating System 18 software by double-click on the icon. From the 
menu bar, select Configuration → Preferences. In the Preferences dialog box select Server.  
 

 

Figure 13. Server settings in coatmaster stand-alone program 
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6. In the field Host or IP address enter the coatmaster IP address (siehe chapter 4.4.1). 
7. Connect the PC and the coatmaster via an ethernet cable. Click Test server connection to 

make sure that the connection can be established. If the server test fails please verify IP ad-
dress and Ethernet connectivity. 

 

To change the IP address, proceed as described in chapter 4.3.1. 

4.4.3 Select language 

Start coatmaster Operating System by double-click on the icon. If the software is not displayed in 
your desired language, select Configuration > Language. 
A submenu appears listing the available languages. Select the corresponding language by clicking on 
it. A dialog appears prompting to restart the software. Confirm with OK and restart the software. The 
program will now open in the selected language. 
 

4.4.4 Define administrator settings within the Operating System 

Under the Administrator tab the software administrator can disable edit and deletion of applications 
for users.  

 
Figure 14. Administrator settings in coatmaster stand-alone software 
 
 
 
To change the settings, click Login.  A Login dialog opens. Administrator password: admino041. Click 
OK. The field Application editable/deletable becomes active. By activating or deactivating the check 
box you can now enable or disable the editing and deleting of applications. The function refers to the 
creation of a new application, to deleting, copying, renaming and editing an existing one and to de-
leting measurement values from the trend area. 
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5 Measuring coating thickness with coatmaster 

5.1 Measuring principle 

The coatmaster operates according to the principle of thermal testing of coatings. Thereby the coat-
ing surface is warmed by means of a light impulse. After the initial warm-up by a few degrees, the 
surface cools down as the heat diffuses in deeper areas of the coating and the substrate.  The evolu-
tion on the surface depends on the physical properties of the coating. The thinner the coating is 
(given that it has a lower thermal conductivity than the substrate), the faster the surface tempera-
ture decreases.  
 

 
Figure 15 Schematic diagram of Thermal Testing of Coatings 
 

5.2 coatmaster application for rough surfaces 

For rough surfaces we recommend to use a reference method such as weighing, or multiple mi-
croscopic cross-section measurements to even out the large variation in thickness results by cross-
section analysis. With a contacting reference method (e.g. electro-magnetic or micrometer 
probes) the surface roughness drastically reduces the repeatability of thickness measurements. A 
large coatmaster measurement spot will reduce dependency of inaccurate part placement. 
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5.3 Measuring with coatmaster Operating System 

coatmaster Operating System must be installed on a Windows computer for making applications and 
running manual and automated measurements. Turn the coatmaster on and after one minute con-
nect the computer with the coatmaster by ethernet: 

• Ethernet: Connect the computer and the coatmaster with Ethernet. This is possible either by 
direct connection with one cable or by integrating the coatmaster in your local network. 

• WIFI: If an optional WIFI dongle has been installed according the guidelines provided by coat-
master AG, the coatmaster can be reached by inserting the provided SSID and password.  
Contact your administrator if you do not know the SSID (name) or password.  

 
After connecting with the coatmaster, start the coatmaster Operating System. The main window 
opens (see Figure 16).  
 

 
 
Figure 16 The main window of the coatmaster Operating System is divided into five areas: 1. Menu, 2. Applications, 3. 
Measurement, 4. Statistics and 5. Trend (see chapter 5.5.3 on page 42 for setting the bounds for warning and error ranges). 
 
Note: 
To restore the main view as shown in Figure 16 select Window > Reset window from the Menu area 
(1). 
 
To check if the coatmaster Operating System is connected to the coatmaster, refer to the status bar 
bottom right.  
 

2 

1 
4 

5 

3 
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To carry out measurements first select the application form the Application area (2). If there is no ap-
propriate application available, you can create it as described in chapter 5.7. If the application is 
greyed out it is not yet complete and requires additional input from the user.  

5.3.1 Manual measurement 

To start a manual measurement refer to the area Measurement (3) in Figure 16: 
 
 

 
Figure 17. Measurement results window in the stand-alone software 
 

A measurement is performed by clicking on the Measurement button . 
The result of the measurement is displayed in the defined units (e.g. µm). 
 
The Statistics area (4) contain statistical values like average, standard deviation, etc., which are calcu-
lated over all measurements in the currently selected block. Blocks are user-defined collections of 
measurements. If you carry out measurements at several positions, you can use for example a new 
block for each measurement position to view the mean value at each position. Each application is 

created with the Default block. To make a new block, press the  -button. New measurements 
will be stored in the block currently selected.  
 
In the Trend area (5) the last measurement values of a block are displayed, ordered according to the 
measurement time. Trends like systematic increase or decrease of the coating thickness are visible in 
this area. A zoom window can be drawn with the mouse to increase the resolution. By means of a 
right-click, single data points can be deleted.   
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Summary of functions in the Measurement area: 
 

 

 

 
Start measuremtent 

 
Starts the measurement 

 

 
 

 
Add a block  

 
Creates a new block where new measurements 
are saved 

 

 

 
Manage blocks 

 
Opens the dialog to manage blocks 

 

 

 
Export measurements 

 
Export the content of the current application, as 
done with File > Export 

 

 

 
Automation mode 

 
Changes the view to the Automation mode (see 
chapter 5.3.2). 

 

5.3.1.1 Manage blocks 

A block is a collection of measurement values. Via the  - button in the block area you can name, 
delete and export blocks.  
 

 
Figure 18. Block management in the stand-alone software 
 
Highlight a block and click “Delete” to delete a block or “Block export” to export the block values 
from the coatmaster to your computer. Read chapter 5.9 for more information on exporting data. 
Click OK to save the settings and close the dialog. Click Cancel to close the dialog without saving. 
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5.3.2 Automated measurement with external sensor 

In the automation mode of the coatmaster Desktop software, the measurement is triggered by an 
external sensor. The sensor has to be connected to the coatmaster, as described below. This function 
enables automated measurement e.g.in a production line. As soon as a part is detected by the sen-
sor, a series of coatmaster measurements can be triggered. 
 
The measurement values are stored on the coatmaster. There are three possibilities to view the 
measurement values that are generated in automation mode: 

1. Export the measurement values to your computer by means oft he Operating System soft-
ware, where they can be treated further with another software (e.g. Excel) (see chapter 5.9). 

2. Display the measurement values live with the coatmaster Desktop software (see chapter 
5.3.2.2). 

3. Display the measurement values live on a connected display (e.g. a tablet or a monitor) with 
the coatmaster Web software (see chapter 5.4.1). 

 

5.3.2.1 Connecting the external sensor 
The xternal sensor is connected to the coatmaster over a standard 15 V interface provided with an 
XLR-connector (see Figure 19). 
 
The sensor connection has the following pin assignment: 

 
Figure 19 XLR-3f connector for external sensor: 1 GND, 2 +15V supply, 3 signal. 

5.3.2.2 Starting and stopping automated measurements with coatmaster Operating System 
 

Start the automation mode by clicking the -icon in the top bar of the Measurement area (3) of 
the main window (see Figure 16). The screen view changes tot he automation view, see Figure 20. 
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Figure 20 Automation view of coatmaster Operating System 
 
To start the automation mode, select an automation configuration (top left) and a measurement ap-

plication (bottom left), then press the -button. The view changes to the active automation 
view. Measurements will be shown in the Trend area (Figure 20). In the status line (bottom) the sen-
sor status is displayed (polling or measurement). To change configuration or application, stop the au-

tomation mode by pressing the -button. To to return to standard measurement view (Figure 

16), press the -button. 
 

5.3.2.3 Creating and editing automation configurations 
 
Prepare an automation configuration by either editing an existing configuration (right click on the 

configuration name > “Edit configuration”) or by adding a new configuration with the  –button 
in the Configuration window. Edit the automation properties to suit your application: 
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Figure 21. Setting for automation in the stand-alone software 
 
Automation name: Name for this configuration that will be displayed in the automation view. 
Polling frequency sensor signal (ms): Time interval for checking the sensor signal. Decrease this 
value to adapt to fast moving objects. For example, an object with speed of 40 m/min will move 3.3 
cm in 50ms. If the measurement spot has to be placed with higher accuracy, decrease the polling in-
terval accordingly. 
Delay between sensor trigger and first measurement(ms): Adjust this time to set the delay between 
sensor trigger and the first measurement. 
Number of measurements after sensor trigger: Set the number of consecutive measurements to be 
executed after the sensor trigger. 
Wait between two measurements (ms): Time delay between consecutive measurements. 
Measure time-out (ms): Time delay after measurement trigger until a time-out error is shown. 
Measurement all n sensor triggers: Set this number greater to one if you want to skip objects that 
are detected by the sensor. For example, a value of 3 will trigger measurements for every third ob-
ject only (skipping two objects). 
Ok: keep changes. 
Cancel: discard changes. 
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Summary of functions of automation view: 
 

 

 
 

 
Start automation 
 

 
Start automation mode 

 

 
 

 
Stop automation 
 

 
Stop automation mode 

 

 
 

 
Quit automation 

 
Quit automation mode and get back to the main window 

 

 
 

 
Warning icon 
 

 
Is displayed next to the measurement value, when it deviations 
significantly from the used application 

 

 
 

 
Error icon 

 
Is displayed next to the measurement value, when it deviations to 
much from the used application 

5.3.3 Measurement statistics 

The Statistics area (4) of the main view of coatmaster Operating System (Figure 16) contains detailed 
statistical information on the measurement data in the currently selected block. Figure 22 shows an 
example of a statistical analysis from block data. 

 
Figure 22 Statistical information of currently selected data block. 
 
�̅�𝑥 : mean value 
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σ: standard deviation 
Min: minimum value in data block 
Max: maximum value in data block 
N(#): number of measurements in the data block 
N below: number of measurements below the lower tolerance bound 
N above: number of measurements above the upper tolerance bound 
 
If the block is changed, the statistics window is updated with the values for the newly selected block. 

5.3.4 Warnings and Errors 

Warnings and errors are are displayed in the Measurement area (3) of the main view (Figure 16). The 
following table lists warning and error icons for the coatmaster: 
 

 

 

 
Measurement 
Warning  
 

 
Indicates a possible deviation of the current measurement to the 
application data. 

 

 

 
Measurement 
Error  

 
Indicates a strong deviation of the current measurement to the ap-
plication data. 

 

 

 
Notification  
Maintenance 
due soon 
 

 
Maintenance of the device is due soon. Inform your administrator 
to organize maintenance cycle. Please have the data from the Help 
> About this coatmaster display ready (see chapter 5.3.5). 

 

 

 
Notification  
Maintenance 
due. 
 

 
Maintenance of the device is due. Operating the coatmaster with-
out due maintenance reduces the life time, causes deterioration of 
accuracy and increases the risk of sudden failure. Inform your ad-
ministrator to organize maintenance immediately. Please have the 
data from the Help > About this coatmaster display ready (see 
chapter 5.3.5). 

 

Measurement 
warning range  

Indicates that a user-specified number of consecutive measure-
ment values lie in the warning range (see description of Display set-
ting for new applications in chapter 5.5 Making new coatmaster ap-
plications ). 

 

Measurement 
error range  

Indicates that a user-specified number of consecutive measure-
ment values lie in the error range (see description of Display setting 
for new applications in chapter 5.5 Making new coatmaster applica-
tions ). 
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For the coatmaster Inline the following additional icons are available: 
 

 

 

 
Warning icon 
Coolant tempe-
rature 

 
Coolant temperature is high. Wait with further measurements until 
the sign disappears. 

 

 

 
Error icon 
Coolant tempe-
rature 

 
Coolant temperature is too high, damage to coatmaster system is 
possible. Shut down the coatmaster and contact your administra-
tor. 

 

 

 
Warning icon 
Coolant flow 

 
Coolant flow is too low. Make sure that the coolant liquid tubes are 
arranged to allow free liquid flow. 

 

 

 
Error icon 
Coolant flow 

 
Coolant flow is critically low, damage to coatmaster system is possi-
ble. Shut down the coatmaster and contact your administrator. 

 

 
 

 
Warning icon 
Coolant level 

 
Coolant level is too low. Refill coolant liquid (see chapter 7.4). 

 

 

 
Error icon 
Coolant level 
 

 
Coolant level is critically low, damage to coatmaster system is possi-
ble. Immediately refill coolant liquid (see chapter 7.4). 

 

 

 
Error icon 
Server / client 
connection 
failed 
 

 
Software incompatibility detected (server / client connection 
failed). Update the software from the coatmaster (see chapter 
4.4.2). 

 
 
 

 

 

 
NOTICE 

Risk of overheating. Too little or too hot coolant liquid within the instrument can lead to over-
heating. 

React to the appearance of the corresponding warning or error icon immediately.  
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5.3.5 System information 

To display information about the software version and the hardware status, press the Help > About 
this coatmaster in the Menu area (1) of the coatmaster Desktop main view (Figure 16).  

 
Figure 23. System information in the stand-alone software 
  
 
Status light source: Indicates the amount of usage of the light source (100% - new light source, 0% - 
light source needs to be replaced). Contact your administrator for replacement of the light source. 
Next service in: Shows the number of days until the next maintenance and service cycle is due.  
 
The coatmaster must be serviced either after 364 days or when the light source reaches 0%. Operat-
ing the coatmaster after reaching either boundary reduces the life time, causes deterioration of accu-
racy and increases the risk of sudden failure. Inform your sales contact to organize maintenance cy-
cle. 
 
Press OK to close this window. 
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5.3.6 Optional windows for main view 

Which areas are visible in the main window can be defined via the menu Window > Show View. 

 
Figure 24. Selection of possible displayed windows and tabs  
 
To display a new area in the main window, highlight the corresponding entry and click OK. 
 
To reset the main window to its default setting, select Window > Reset Window. 
Now the areas Applications, Measurement, Statistics and Trend of the selected Application are dis-
played. 
 
NOTICE 
A submenu is available when right-clicking the charts in the areas Statistics, Trend and Data Chart, 
enabling to define the properties of the chart, to save and print it, zoom in and out, defining an auto 
range, exporting the chart and deleting it. 
 
These windows have the following names and functions: 
 
Last: Shows the last measured value 
Automation Log: Log of all Automation Control data 
Data Chart: Display measurement signals as time curves 
Data: Display measurement signals in numeric table form 
Device Log: Used for service operation only. 
Test: To carry out a device test, e.g. a defined amount of successive measurments  
Workspace: Used for service operation only. 
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5.3.6.1 Test 

5.3.6.2 Status 
For the coatmaster Inline, the status window shows the current temperature, the flow and the level 
of the coolant liquid. 
 

 
Figure 25. Status window showing sensor data in the stand-alone software 
  
 
Threshold value for warnings: 
 
Temperature: 40 °C 
Coolant flow: 2 l/min 
Coolant level: 20 % 
 
Threshold value for errors (measurement is no longer possible): 
 
Temperature: 60 °C 
Coolant flow: 1l/min 
Coolant level: 10 % 
 
Note: 
To restore the factory main view as shown in Figure 16 select Window > Reset window from the 
Menu area (1). 
 

5.4 Measuring with the Web Client  

Connect you computer with the coatmaster and start the Web Client software as described in chap-
ter 4.4.1. The following screen appears: 
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Figure 26. Web client homepage 
 
Click Measure, a selection dialog with all applications saved on the coatmaster appears: 
 

 
Figure 27. Choosing the application in the web client 
 
Click on the row with the application to use for the measurement. If the corresponding application is 
not available, it has to be created first (see chapter 5.7). 
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Figure 28. Measurement window in the web client 
 
Start the measurement by pressing Start measurement. The measured value is plottet on the curve 
diagram and displayed above the diagram in the selected unit. 
The grey area on the diagram marks the tolerance range. The red area on both sides marks the out-
side of the tolerance range. The tolerance range is defined in the application. The black dotted line in 
the center shows the mean value. 
 
The mean value (Avg.), standard deviation (Std. dev.) and the number of performed measurements 
(N) are displayed on the right above the curve diagram. By pressing Reset the course of measure-
ment is deleted.  

5.4.1 Monitor 

The Monitor option allows to display values from measurements with external triggering (either sen-
sor or remote control software). After clicking Monitor a selection dialog appears: 
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Figure 29. Choosing the application to monitor in the web client 
 
Click on the row with the application to monitor. The following dialog opens: 
 

 
Figure 30. Monitoring measurements in the web client 
 
Press Start to activate the monitoring function. When the coatmaster is running in automatic mode 
or measurements are triggered by remote control software, the course of meausurement can be 
controlled continously by means of this screen. 
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5.4.2 Settings of coatmaster Web Client 

 
Figure 31. Settings in the web client 
 
In this dialog the settings for displaying measurement trends with coatmaster Web client are de-
fined. 
Number of saved measurements: Number of recent measurements to be saved on the device. 
Number of displayed measurments: Number of recent measurements displayed in the measure-
ment curve. 
Caption x-axis: Either the measurement time or the measurement index can be selected as caption 
for the x-axis.  
Calculate mean value and standard deviation for the last X values: Number of last measured values 
for which the mean value and the standard deviation are to be calculated. 
 
Click Save to save the settings. 
  

5.5 Making new coatmaster applications  

This function is only available in the coatmaster Operating System. 
 
Coating processes are specified by an upper and lower limit value for the coating thickness (tolerance 
window). For calibration by reference measurements, we recommend to use at least one sample 
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with a coating at the lower boundary and one sample at the upper boundary of the tolerance win-
dow. On these reference samples, carry out 2-4 measurements each with the coatmaster and mark 
the measurement points, so that the coating thickness can be measured with a reference method at 
the same measurement points later on. 
For best results we recommend to use the same materials and parts for calibration as used later for 
measurement. However, the coatmaster tolerates certain deviations between calibration and meas-
urement as follows: 

1. Calibration on metal substrate and measurement on substrate with slightly different alloy 
combinations (e.g. different steel types).  

2. Calibration on thin plates, measurement on thick plates or vice versa (activate the checkbox 
Enable variation of substrate properties in the software).  

3. Calibration on plane surfaces, measurement on round surfaces. 
4. A certain amount of temperature variation is acceptable, depending on coating and substrate 

material. 

The following factors influence the coatmaster measurement, so that there should be the same con-
ditions during calibration and measurement: 

1. Surface roughness: If the measurement is carried out on rough surfaces, the calibration 
should be done on rough surfaces as well. 

2. Coating surface: If only a small area or a discontiguous area is coated, the calibration should 
be done on the reduced area as well. 

3. Substrate material: In case the same coating is measured on different substrate materials 
(e.g. on metal or plastic or on aluminium or steel) for each subtrate material a new coatmas-
ter application should be created. 

The reference samples should be kept, if possible, to check the long-term stability of the coatmaster. 
  
To make a new application, produce the reference samples and keep them at hand for the calibration 
process. Switch on the coatmaster and start the coatmaster Desktop. In the Application area on the 
left-hand side click the button New application (see Area 2 in Figure 16 on page 23). If this button is 
greyed-out, the administrator has locked this feature for the user (factory setting). To unlock this fea-
ture, please enter the administrator password (refer to chapter 4.4.4). 
 
Follow the application setup procedure as follows. 

5.5.1 Setup application 

 After clicking on the New Application button, the application setup dialog starts: 
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Figure 32. Setting up an application in the stand-alone software 
 
In the field Name enter a name for the new application.  
Under Coating select the best suiting coating material from the drop-down menu. If no suitable coat-
ing material is available, choose Unknown. 
If necessary, change the Tolerance settings for the coating. Fill in the fields for the upper and lower 
limit to define the tolerance window. 
Under Substrate select the best suiting substrate material from the drop-down menu. 
If necessary, change the Tolerance settings for the substrate. Fill in the fields for the upper and lower 
limit to define the tolerance window. 
Under Calibration method select the radio button Measurement, when the calibration is done via a 
measurement or Material, when the calibration is done according to the existing material database 
of the coatmaster.  
 
NOTICE 
When Material is selected, the new application becomes available without needing further steps and 
can be finished by clicking on Save. The calibration is done according to material properties stored in 
the material data base. Our data base is continuously expanded and updated. However, deviations of 
the coating material to the standard materials stored in the data base may lead to errors in the meas-
urement values. For more accurate results, use the calibration by reference measurements. 
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Offset: Leave the checkbox Thickness Offset inactive at this state. You need more information about 
the correlation between the coatmaster measurements and the reference measurements to decide 
about this option. This information is available after you have run the calibration procedure (see 
chapter ). 
 
Click Next >. The following dialog appears: 
 

5.5.2 Reference measurements 

 

Figure 33. Adding calibration measurements in the stand-alone software 
 
To carry out a new reference measurement, place the object to be measured in front of the coatmas-
ter’s measurement window and click Add to carry out the coatmaster measurement. Alternatively 
the measurement can be triggered by external sensor or by TCP command. This feature can be acti-
vated by selecting external trigger in the Reference -window. 
 
Add at least one reference measurement for all calibration samples. For each coatmaster reference 
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measurement, add the reference thickness value by clicking in the reference value field. The refer-
ence thickness value is often determined by electromagnetic hand-held coating thickness gauges or 
microscopic cross-section analysis. 

Please refer to chapter 5.6 on p. 51 for making applications on coatings before curing. 

If not all reference thickness values have been specified for all coatmaster reference measurements, 
it is not yet possible to proceed with the calibration. However, the application can be saved using the 
Save button. A saved application can be edited and the reference thickness values can be entered at 
a later stage. 

If all reference thickness values are available, the Next> button is activated. Pressing the Next> but-
ton runs the calibration algorithm. The results of the calibration are displayed in the calibration re-
port (see chapter Calibration report5.5.7). 

For each application, further parameters can be configured. These parameters control the display of 
the measurement values (chapter 5.5.3), the light energy and measurement time (chapter 5.5.4) and 
measurement evaluation (chapters 5.5.5 and 5.5.6).  

5.5.3 Display 

This tab contains further settings on displaying the measurement values. 
 

 
Figure 34. Choosing the limits for measurements in the stand-alone software  



coatmaster Inline/Atline 
 

43 

 
Decimal places for coating thickness: Set number of decimal places for display. 
 
The trend window can be divided into three areas: tolerance (grey), warning (light orange) and error 
(dark orange). If a specified number of consecutive measurements lie in the warning range, the warn-

ing range symbol  is indicated in the Measurement window. If a specified number of consecu-

tive measurements lie in the error range, the error range symbol  is indicated in the Measure-
ment window. In the error case, it is possible to configure an error message that must be confirmed 
by the user before measurements can proceed. 
 
Specification of tolerance, warning and error ranges  
Tolerance: Specify the lower and upper boundaries for the tolerance range for the coating thickness 
in the trend window (grey area). No. of measurements until warning: Specify the number of consecu-
tive measurements in the warning range that trigger the warning range symbol. 
Error:  Specify the lower and upper boundaries between warning and error range for the coating 
thickness in the trend window. No. of measurements until error: Specify the number of consecutive 
measurements in the warning range that trigger the error range symbol. 
 
Range: Specify the lower and upper display boundaries for the trend window. 
 
See the below example showing tolerance, waning and error ranges in the trend window, corre-
sponding to the settings in the Display tab of the application settings: 
 

 
Figure 35. All measuremnts in a block are plotted in the Trend window 
  
 
NOTICE 
Settings for tolerance range, units and decimal places affect only the the trend chart and the display 
of the measurement values and have no influence on calculation of measurement values. 
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Click Save to save the new application, add it to the application list and close the dialog. 
Click Cancel to close the dialog without saving. 

5.5.4 Device 
 

 

Figure 36. Setting the measurement duration, light energy and SNR threshold in the stand-alone software 
 
 
Measurement time (ms): set the length of the dynamic surface temperature measurement. The field 
contains a default value determined by your choice of coating material and thickness range.  
 
Light energy (J): Set the energy level of the light flash. This option is only available if no reference 
measurements are stored in the application! Increase this value to increase the SNR in order to gain 
better repeatability or to increase the distance between coating surface and coatmaster. Too little 
SNR can be a cause for unsuccessful calibration. 
 
SNR threshold: Measurements with SNR value below this threshold will be discarded. Set the SNR 
threshold to some value lower than the SNR value shown in the calibration report. If the SNR thresh-
old value is too high, valid measurements will be discarded. If the SNR threshold value is too low, in-
valid measurements might not be discarded. 
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5.5.5 Evaluation 

 
Figure 37. Settings for evaluation in the stand-alone software 
 
 
Allow variation of substrate properties: This checkbox must be activated if the calibration and the 
measurement are carried out on substrates with different thickness (e.g. different metal sheets).  
 
NOTICE 
For optimum results we recommend to carry out the calibration and the measurement under as simi-
lar conditions as possible. 
 
Allow variation of surface properties: Activate this checkbox when the surface roughness can vary,  
for semitransparent coatings or when the coating is so thin that the substrate is visible through the 
coating. This setting can increase the measurement quality in an unsuccessful calibration. 
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The fields Warning and Error list the corresponding threshold value marking the limit for a warning 
or an error message (rating a later measurement as unsuccessful), when the measurement value de-
viates too much from the used application. In case of a warning, the warning icon is shown in the 
main window next to the measurement value. In case of an error, the error icon is shown. 
The predefined settings are a proposal according to the measurement data aquired with the applica-
tion.  
 

5.5.6 Bounds 

The settings in this dialog are predefined according to the material settings for the application. 
To modify the settings in this dialog, the checkbox user-defined must be activated. 
 
NOTICE 
These settings have a strong influence on the application quality and thus on the quality of the meas-
urement results. They are reserved to experts with technical knowledge. 

 
Figure 38. Upper and lower parameter limits for the evaluation. Note: Should not be changed without expert knowledge! 
 
Layer time constant: Time needed by the heat to penetrate the layer 

Optical constant: Indicates, how deep the light or the heat, respectively, penetrates the coating, i.e. 
qualifies the absorptive properties of the coating 
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Effusivity contrast: Indicates the contrast in thermal properties of coating and substrate  

Contact resistance: Indicates, whether the heat has to overcome a barrier when passing the transi-
tion between two coatings or between the coating and the substrate 

Gain: Indicates, how far the coatmaster is away from the sample, i.e. how well the heat is absorped 
and emitted again. 

5.5.7 Calibration report 

After the calibration process is finished, the result of the calibration is shown in the Calibration re-
port. 

 

Figure 39. Calibration results in the stand-alone software. 
 

The calibration algorithm determines if the correlation between the coatmaster and the reference 
measurements is good and if the coatmaster measurements are reliable. The algorithm uses the fol-
lowing measures: 

Mean deviation: 
> 25 %: The deviation between coatmaster and reference measurements is too large.  
between 10 and 25 %: correspondence is not optimal. 
< 10 %: correspondence is acceptable. 
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Means to reduce the mean deviation: 
• Possibly an outlier or a bad reference measurement is present. This is the case if the points in 

the correlation graph generally lie on a straight line, except one point. In this case, remove 
the outlier point in the reference measurement list by pressing the <Back button. 

• Possibly the coatmaster measurements were disturbed. Repeat all coatmaster reference 
measurements. 

• If the points in the correlation graph lie on straight line but not on the calibration line, acti-
vating the Offset option improves the mean deviation. 

 
 
Quality index: 
> 94 %: This quality index is good. 
Between 90 and 94%: This quality index is acceptable, but might be improved. A higher quality index 
could result in more accurate measurement.   
< 90 %: This quality index is not good.  
 
Means to improve the quality index: 

• Possibly the materials selected for coating and substrate are a bad match for the real materi-
als.  In this case, choose the entry unknown for substrate and coating material. 

• Repeat the blank measurements, as described in chapter 7.6. 
 
SNR:  
< 20: An SNR value less than 20 is very low and can lead to unreliable measurements. 
 
Means to improve the SNR: 

• Position the part closer to the measurement opening of the coatmaster. Do not put the sur-
face of the part closer than 5cm to the measurement opening of the coatmaster. Please note 
that changing the distance between the part and the measurement opening also changes the 
measurement spot size.  

• Increase the light energy in the application. You will have to delete all previous reference 
measurements to be able to change the light energy setting. 

• If both measures do not help, use an optical reflex amplifier. 
 

5.5.8 Application offset 

The data plot of coatmaster and reference measurement might sometimes show systematic devia-
tion between reference and coatmaster values. This can be detected by the fact that for thin coatings 
all calibration points are located above the calibration line while for thick coatings all calibration 
points are below (or vice-versa). The following example illustrates this situation: 
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Figure 40. Calibration results in the stand-alone software 
 
Although the mean deviation is below the 25% limit that causes an unsuccessful calibration, a sys-
tematic deviation of the coating thickness value of reference and coatmaster is evident. In this case it 
is appropriate to allow the offset for this application. For this purpose select Back twice to get back 
to the frist page, activate the option Thickness offset and select Next twice. 

After enabling the Offset, the data plot now shows smaller mean deviation: 
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Figure 41. Calibration results in the stand-alone software 
 
Offset: Shows the offset of the calibration (in this case 11 µm).  

The offset enables to balance systematical deviations between reference and coatmaster. Such devi-
ations can especially occur on rough or porous substrates / coatings. To correctly determine the off-
set at least four to eight reference measurements are necessary. 
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5.6 coatmaster applications for coatings before curing 

The coatmaster can be used to measure coating thickness before curing without touching (and thus 
destroying) the coating. This allows to use the coatmaster for process control and to measure pro-
cess statistics.  For this purpose, the coatmaster can be configured to predict cured coating thickness 
from measurements before curing. The steps required to make an application are described in chap-
ter 5.6.3. 
 
Special considerations must be made for measuring before curing, depending on the type of coating 
(powder or wet), as described in chapters 5.6.1 and 5.6.2. 

5.6.1 Measuring powder coatings before curing 

Powder coatings are not even in thickness, rather the surface is wavey and the thickness changes 
within few millimeters’ distance. This waviness is influenced by different parameters such as pre-
treatment, type and waviness of the substrate, paint type (e.g. grain size distribution and chemical 
composition). The waviness is also still visible after curing, and depends on curing conditions (tem-
perature distribution, curing times). Figure 42 shows a 2x2 mm extract of a powder coating surface 
with thickness differences of 15µm. 

 
Figure 42: Waviness of powder coating after curing 
 
The measurement principle of the coatmaster can compensate this waviness by an optical averaging. 
This allows reliable determination of the coating thickness. 
 

5.6.2 Measuring wet coatings before curing/drying 

The wet coating thickness is usually measured to determine the thickness of the coating after curing. 
This only produces repeatable results if the ratio of solvent to solids remains constant. However, in a 
wet coating the solvent evaporates, so that the ratio changes with time. Therefore, the coatmaster 
reference measurements should be made in the same state of the coating as when the coatmaster is 
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to be used to make measurements.  
 

5.6.3 Procedure to make coatmaster applications for measuring coating thickness before curing 

1. Produce reference parts to be used for the coatmaster application. These parts should cover 
the range to be measured by the coatmaster. This range can for example be the tolerance 
range of the coating process. We suggest to make two parts at minimum and two parts at 
maximum thickness of the measurement range. 

2. Make a new application on the coatmaster as described in chapter 5.5 Making new coatmaster 
applications . Give a name to this application that indicates that this application is to be used 
for measurement in the process (e.g. “wet state”). On each reference part, if possible, take 
two reference measurements with the coatmaster at different positions. Press Save after tak-
ing the reference measurement without entering the reference values. Make sure the posi-
tions of the reference measurements can be found again, e.g. by marking without destroying 
the coating at the measurement positions. This gives a total of eight reference measurements 
for the coatmaster applications. Depending on the precision of the method to measure the 
reference value, the number of required measurements might change. 

3. Finish curing the coating on the reference parts. 
4. Measure the coating thickness on the reference parts in the marked positions with a reference 

method (e.g. microscopic cross-section analysis). Enter the coating thickness in the “wet” coat-
master applications. 

5. If possible and required, make a second new application on the coatmaster, adding reference 
measurements on the cured reference parts at the same positions. If the parts have been cut 
for microscopic analysis, make the reference measurements close to the original position. Give 
a name to this application that indicates that this application is to be used on cured parts only 
(e.g. “cured state”). This application is only required for periodic verification of proper func-
tioning of the coatmaster on the reference parts. 

6. Repeat the measurements on the reference parts with the “cured” coatmaster application at 
the marked positions. Note down the coating thickness values from the coatmaster for each 
position. These values should be close to, but might not be the exactly same as the values from 
the reference method. The coatmaster should always produce these same values when re-
peating the measurements on the reference parts. 

 

5.7 Back-up and Transfer of coatmaster applications 

Application data is stored in the coatmaster’s embedded PC. If this PC crashes or is destroyed the 
work to create the applications is lost. It is therefore suggested to download applications by export-
ing this data from the coatmaster to an external storage. Furthermore, applications can also be trans-
ferred between different coatmaster systems.  
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5.7.1 Export applications 

To export an application, selet File > Export. The following dialog appears: 
 

 
Figure 43. Export window in the stand-alone software 
 
Double-click Application, select the submenu Export Application and click Next >. The following dia-
log appears: 
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Figure 44. Window for exporting an application in the stand-alone software 
 
From the list of applications, select those to be exported and click the button ..., to define the path 
and the name of the export file. Click Save and then Finish in the export dialog. The export file is now 
saved as *.cmz-file under the defined name and path. 
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5.7.2 Import applications 

To import previously exported applications, select File > Import. The following dialog appears: 
 

 
Figure 45. Window for importing an application in the stand-alone software 
 
Double-click Application, select the appearing submenu Import Application and click Next >. The 
following dialog appears: 
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Figure 46. Selecting the application to import in the stand-alone software 
 
Click the button .... In the appearing dialog select the *.cmz-file to be imported and click Open. The 
corresponding path is shown in the import window. Then click Finish. The application file is now im-
ported and added to the lists of applications. 
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5.8 Import a material file 

To import the settings for a coating or substrate material, select File > Import. Such data is only avail-
able form coatmaster AG upon request for new coating or substrate materials. The following dialog 
appears: 
 

 
Figure 47. Importing material files in the stand-alone software 
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Double-click Material, select the appearing submenu Import Material and click Next >. The following 
dialog appears: 

 
Figure 48. Selecting the file to import in the stand-alone software 
 
Click the button .... In the appearing dialog select the *.xml-file to be imported and click Open. Then 
click Finish. The settings for the selected material are imported and are now available for application 
development. 
 

5.9 Export measurement data 

To export the measurement data, select File > Export or click the -icon in the Application area of 
the main window. The following dialog appears: 
 

 
Figure 49. Exporting measurement data in the stand-alone software 
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Double-click Data, select the appearing submenu Export data and click Next >. The following dialog 
appears: 
 

 
Figure 50. Selecting the measurements to export in the stand-alone software 
 
 
With the filter settings for date and time select the period for which the data should be exported and 
click the update button with the two arrows. Then click Export.... A Save as dialog opens, where the 
path and name for the data file can be defined. Now click Save. The export file is now saved as XML-, 
CSV- or QDAS-file under the defined name and path. 
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6 Remote control 

This chapter describes operation of the coatmaster using any device that connects to the coatmaster 
by Ethernet. This can be for example a PLC (e.g. Siemens S7) or a computer running software from a 
third party. The coatmaster Operating System software is using remote protocol to control the coat-
master. 
 
The coatmaster is operated by commands that are sent from the device to the coatmaster. The result 
of the command is sent back from the coatmaster to the device. The coatmaster acts as a server for 
remote control operation. The device acts as a client.  
 
It is possible to use either a TCP/IP or a HTTP based interface for remote control of the coatmaster.  
 
To use the TCP/IP interface, proceed as follows: 
 
Commands and results for the TCP/IP interface are listed in chapter 6.1. 
 
To use the HTTP interface, proceed as follows: 
 
Commands and results for the TCP/IP interface are listed in chapter 6.1.15. 
 

6.1 TCP/IP  

The commands and the results are transferred as ASCII text lines. After a command is processed, the 
TCP/IP connection is disconnected by the coatmaster server, to allow access by other clients. The 
connection has to be re-established for the next command. 
 
Code examples using the TCP/IP protocol are available from the following link:  
https://coatmaster.com/en/integratoren.html  
 
Important note for users of a Siemens SIMATIC S7 PLC: 
The Siemens S7 PLC is available in two different product types, which react differently with an Ether-
net connection – Type PN/DP and Type DP.  
 
Type PN/DP: This type has Ethernet integrated in the CPU. The opening and closing of the Ethernet 
connection is done automatically and requires no special commands in the software.  
 
Tyep DP: This type does not have Ethernet integrated in the CPU. For this type, the Ethernet connec-
tion must be opened before each command and closed after each command by software.  
 

https://coatmaster.com/en/integratoren.html
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6.1.1 General format of commands and results 

A command line string has the following format:  
COMMAND?ARG1=VAL1&ARG2=VAL2&...CR/LF 
 
The elements in a command line have the following meaning: 
„COMMAND“: Command name 
„?“: Separates a command from the arguments 
„ARGx“: Name of a command argument 
“VALx”: Value for the command argument 
„=“: Separator sign between command argument and value  
„&“: Separator sign between command arguments 
<...>: Place holder for dynamic values 
-----: Separator line 
„CR/LF“: ends the command (line break (Hex 0D 0A, escape sequence \r\n)) 
 
The coatmaster responds to commands with results with similar formats: 
 
RESULT?ARG1=VAL1&ARG2=VAL2&...CR/LF 
 
„RESULT“: Result name 
„?“: Separates a command from the arguments 
„ARGx“: Name of a command argument 
“VALx”: Value for the command argument 
„=“: Separator sign between command argument and value  
„&“: Separator sign between command arguments 
<...>: Place holder for dynamic values 
-----: Separator line 
„CR/LF“: ends the command (line break (Hex 0D 0A, escape sequence \r\n)) 
 
The argument STATUS is contained in every command result and assumes the following values: 

• OK: The command was carried out correctly. 
• ERROR: The command was not carried out correctly and aborted. 
• WARNING: Warning, e.g. when the measuring values are not reliable 
• MESSAGE=<VAL>: Description of the problem in case of an error or warning message 
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6.1.2 MEASURE command 

Use the MEASURE command to trigger a coatmaster measurement. You have to select a coatmaster 
application for the measurement. This is specified by an ID and is only argument for the MEASURE 
command. 
 

Command Arguments Description 
MEASURE CONFIGID  Execute a measurement using the application with ID 

specified by CONFIGID. The IDs of all applications stored 
on the coatmaster can be retrieved with the command 
GETCONFIGURATIONS. 

 
Example usage 
Command to trigger a measurement with application ID no. 1: 
MEASURE?CONFIGID=1<CR/LF> 
 

Result Arguments Description 
RES_MEASURE STATUS As described in chapter 6.1.1. 
 MEASURE_ID Each measurement result receives a unique ID number 

(integer). 
 THICKNESS Coating thickness result (floating point number) 
 TIMESTAMP Time stamp of the measurement (integer). The value of 

this argument stands for „milliseconds since January 1, 
1970, 00:00:00 GMT". See http://www.epochcon-
verter.com/ for further description how to convert this 
number into your desired time format. 

 
Example result: 
RES_MEASURE?STATUS=OK&MEASURE_ID=3&THICK-
NESS=12.0&TIMESTAMP=1362061773072<CR/LF> 
 
In this example, the measurement result is 12.0μm and the value 1362061773072 stands for the time 
specification 28. February 2013, 14:29:33 GMT.   
 
Error and warning messages 
As a result to a MEASURE command, warning and error messages could be returned. In this case, the 
result has the format: 
 
RES_MEASURE?STATUS=ERROR&MESSAGE={error message}<CR/LF> 
RES_MEASURE?STATUS=WARNING&MESSAGE={warning message}<CR/LF> 
 
The text part in the braces {…} contains a code for the warning or error: 
 

http://www.epochconverter.com/
http://www.epochconverter.com/
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Argument Values Description 
MESSAGE 1 Description of error 1 
 2 Description of error 2 

 

6.1.3 GETCONFIGURATIONS command 

Use the GETCONFIGURATIONS command to retrieve a list of all applications stored on the coatmas-
ter. This command has no arguments. 
 

Command Arguments Description 
GETCONFIGURA-
TIONS 

  

 
Example usage:  
GETCONFIGURATIONS<CR/LF> 
 

Result Arguments Description 
RES_GETCONFIGURA-
TIONS 

NAME Name given to the application by the user 

 ID Application ID for this application (integer) 
 … For each application stored on the coatmaster, 

the NAME and ID is returned. 
 
Example result: 
RES_GETCONFIGURATIONS?STATUS=OK&ID=2&NAME=paint1&ID=4&NAME=paint2<CR/LF> 
 
In this example, there are two applications stored on the coatmaster. Application with name “paint1” 
has ID 2 and the application with the name “paint2” has ID 4. IDs do not have to be consecutive num-
bers. 

6.1.4 GETCONFIGIDS command 

Use the GETCONFIGIDS command to retrieve a list of the IDS of all application stored on the coat-
master. This command has no arguments. 
 

Command Arguments Description 
GETCONFIGIDS   

 
Example usage:  
GETCONFIGIDS<CR/LF> 
 

Result Arguments Description 
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RES_GETCONFIGIDS STATUS As described in chapter 6.1.1. 
 ID First application ID (integer) 
 … For each application stored on the coatmaster, 

the ID is returned. 
 
Example result: 
RES_GETCONFIGIDS?STATUS=OK&ID=2&ID=3&ID=5<CR/LF> 
 
In this example, there are three applications stored on the coatmaster. They have IDs 2, 3 and 5. IDs 
do not have to be consecutive numbers. 
 

6.1.5 GETTHICKNESSBOUNDS command 

Use the GETTHICKNESSBOUNDS command to retrieve a list of the warning and error coating thick-
ness boundaries specified in an application. See chapter 5.5.3 on page 42 for more information on 
warning and error coating thickness bounds. 
 

Command Arguments Description 
GETTHICKNESS-
BOUNDS 

CONFIGID Specify the ID of the application for which you want to get 
the coating thickness bounds information. 

 
Example usage:  
GETTHICKNESSBOUNDS?CONFIGID=1<CR/LF> 
 

Result Arguments Description 
RES_GETTHICKNESS-
BOUNDS 

STATUS As described in chapter 6.1.1. 

 HAS_WARNING Boolean variable (either TRUE or FALSE) show-
ing if a warning range is defined for the appli-
cation (see chapter 5.5.3 on page 42). 

 WARN-
ING_LOWER 

Lower coating thickness bound in micrometers 
for warning range (integer). Only defined if 
warning range is active. 

 WARNING_UPPER Uppter coating thickness bound in microme-
ters for warning range (integer). Only defined 
if warning range is active. 

 HAS_ERROR Boolean variable (either TRUE or FALSE) show-
ing if an error range is defined for the applica-
tion (see chapter 5.5.3 on page 42). 

 ERROR_LOWER Lower coating thickness bound in micrometers 
for error range (integer). Only defined if error 
range is active. 
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 ERROR_UPPER Upper coating thickness bound in micrometers 
for error range (integer). Only defined if error 
range is active. 

 
Example result: 
RES_GETTHICKNESSBOUNDS?STATUS=OK&HAS_WARNING=true&WARNING_LOWER=50&WARN-
ING_UPPER=60&HAS_ERROR=false&ERROR_LOWER=10&ERROR_UPPER=150<CR/LF> 
 
In this example, the warning range is active whereas the error range is not active for the application. 
Lower boundary for warning range is 50μm, upper boundary for warning range is 60μm. The values 
for lower and upper boundaries for error range are irrelevant. 
 

6.1.6 STARTAUTOMATION command (automation mode) 

This command is intended to be used in conjuction with the automation mode of the coatmaster Op-
erating System. See chapter 5.3.2 on page 26 for further details on the automation mode. 

6.1.7 STOPAUTOMATION command (automation mode) 

This command is intended to be used in conjuction with the automation mode of the coatmaster Op-
erating System. See chapter 5.3.2 on page 26 for further details on the automation mode. 

6.1.8 TRIGGERAUTOMATIONSENSOR command (automation mode) 

This command is intended to be used in conjuction with the automation mode of the coatmaster Op-
erating System. See chapter 5.3.2 on page 26 for further details on the automation mode. 
 

6.1.9 GETAUTOMATIONSTATE command (automation mode) 

This command is intended to be used in conjuction with the automation mode of the coatmaster Op-
erating System. See chapter 5.3.2 on page 26 for further details on the automation mode. 
 

6.1.10 CREATESAMPLE command (automation mode) 

This command is intended to be used in conjuction with the automation mode of the coatmaster Op-
erating System. See chapter 5.3.2 on page 26 for further details on the automation mode and chap-
ter 5.3.1.15.3.3  on page 25 for further information on sample blocks. 
 

Command Arguments Description 
CREATESAMPLE CONFIGID Specify the ID of the application for which you want to 

generate a new sample block.  
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Example usage:  
CREATESAMPLE?CONFIGID=12<CR/LF> 
 
This will make a new sample block in application with ID 1. 
 

Result Arguments Description 
RES_CRE-
ATESAMPLE 

SAMPLE_ID The ID of the newly created sample block (integer). 

 
Example result: 
RES_CREATESAMPLE?SAMPLE_ID=211<CR/LF> 
 
The new block has the ID number 211. The block is automatically set active by the coatmaster Oper-
ating System. 
 

6.1.11 GETNUMBEROFMEASUREMENTS command 

Use the GETNUMBEROFMEASUREMENTS command to … 
 

Command Arguments Description 
GETNUMBEROF-
MEASURE-
MENTS 

  

 
Example usage:  
  
 

Result Arguments Description 
RES_GETNUM-
BEROFMEAS-
UREMENTS 

  

 
Example result: 
 

6.1.12 GETSERVICESTATUS command 

Use the GETSERVICESTATUS command to … 
 

Command Arguments Description 
GETSERVICESTA-
TUS 
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Example usage:  
  
 

Result Arguments Description 
RES_ GETSERVICESTATUS   

 
Example result: 
 

6.1.13 GETAMBIENTSENSORDATA command (coatmaster Inline only) 

Use the GETAMBIENTSENSORDATA command to query the status of the ambient sensors. See also 
chapter  on page . 
 

Command Arguments Description 
GETAMBI-
ENTSENSOR-
DATA 

  

 
Example usage:  
GETAMBIENTSENSORDATA <CR/LF> 
 
The format of the result depends on the STATUS. 
 
STATUS=OK: 
  

Result Arguments Description 
RES_GETAMBI-
ENTSENSOR-
DATA 

STATUS OK 

 SENSOR-STATUS NORMAL 
 TEMPERATURE Temperature of the cooling liquid in °C (floating point 

number). 
 WATER-FLOW Flow of the cooling liquid in l / min (floating point num-

ber). 
 WATER-LEVEL Level of the cooling liquid in the tank in % (floating point 

number). 
 
STATUS=ERROR: This is the case if any one of the sensor values falls below pre-defined thresholds. 
The sensor that is below the threshold level is indicated after the SENSOR-STATUS-… field: 
  

Result Arguments Description 
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RES_GETAMBIENTSENSOR-
DATA 

STATUS ERROR 

 SENSOR-STA-
TUS-TEMPERA-
TURE 

CRITICAL (only present if this sensor is in critical 
level) 

 SENSOR-STA-
TUS-WATER-
FLOW 

CRITICAL (only present if this sensor is in critical 
level) 

 SENSOR-STA-
TUS-WATER-
LEVEL 

CRITICAL (only present if this sensor is in critical 
level) 

 TEMPERATURE Temperature of the cooling liquid in °C (floating 
point number). 

 WATER-FLOW Flow of the cooling liquid in l / min (floating point 
number). 

 WATER-LEVEL Level of the cooling liquid in the tank in % (float-
ing point number). 

 
 
Example result with STATUS=OK: 
RES_GETAMBIENTSENSORDATA?STATUS=OK&SENSOR-STATUS=NORMAL&TEMPERA-
TURE=3.0&WATER-FLOW=7.0&WATER-LEVEL=600.0<CR/LF> 
 
Example result with STATUS=ERROR: 
RES_GETAMBIENTSENSORDATA?STATUS=ERROR&SENSOR-STATUS-WATER-FLOW=CRITI-
CAL&SENSOR-STATUS-WATER-LEVEL=CRITICAL&WATER-FLOW=1.0&WATER-
LEVEL=0.0<CR/LF> 
 

6.1.14 GETCOATMASTERSTATUS 

 
Command Status Description 
GETCOATMAS-
TERSTATUS 

STATUS Is Coatmaster ready? Command for TCP/IP to check if 
measure can be performed 

 HAS_STARTUP Is system start-up conducted 
 STARTUP_WAIT_RE-

MAINING 
How long (ms) the start-up takes 

 FLASH_READY Is light source ready to be used 
 FLASH_WAIT_RE-

MAINING 
How long (ms) the charging take 

 READY Are light source and start-up conducted 
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 CURRENT_ACTIVITY “Measure”, “Evaluation” or “None”. During “Meas-
ure” the device shold not be moved, during “Evalua-
tion” the device can be moved to new position, during 
“None” the device is ready to be used. 

   
 

6.1.15 GETOBJECTTEMPERATURE 

Command Status Description 
GETOBJECTTEM-
PERATURE?CON-
FIG_ID=XXX&MEAS-
URE_ID=YYY 
 

 Config_ID is the name of the application and meas-
urement the corresponding measurement number 
in this application 

 STATUS OK, if measurement succesfull 
 TEMPERATURE Measured temperature value 

 

6.1.16 GETLASTOBJECTTEMPERATURE 

Command Status Description 
GETLASTOB-
JECTTEMPERA-
TURE 

STATUS OK, if measurement succesfull 

 TEMPERATURE Returns the last measured temperature 

 

6.2 HTTP 

Start a measurement: 
Request URI: http://{host:port}/measurementserver/measure?configID=/{Appl-ID} 
Request method: POST 
Request headers: {Accept=[application/json], Content-Length=[0]}     
 
{host:port} must be replaced by TCP/IP address and port, e.g. http://192.168.1.100:1234/measure-
mentserver/ etc. 
 
{Appl-ID} stands for the application used for the measurement. The application IDs of all applications 
defined within the coatmaster are stored in the application list under their application name. 
 
Query application list:  
Request URI: http://{host:port}/measurementserver/configurations 
Request method: GET 
Request headers: {Accept=[application/json], Content-Length=[0]}     
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7 Maintenance / Service 

Maintenance / Service may be conducted by authorized personnel only! Unauthorized personnel risk 
personal injury and damage to the coatmaster! 
 
Use only coatmaster AG consumables and spare parts for maintenance and repair to assure system 
performance and reliability. Any modifications to the spare parts are only allowed with the prior writ-
ten permission of coatmaster AG. 

7.1 General 

 

 

 
WARNING 

Risk of burns by electric current. Serious injuries or death can result. 

Prior to any maintenance and service, switch off the device and unplug the mains cable. Mainte-
nance work may be conducted by authorized personnel only! 

 

 
Do not open the housing of the coatmaster, even when the coatmaster is not connected to the 
mains. Exception: Unmounting the the rear cover for cleaning or exchanging the filter pads (see sec-
tion 7.3). Opening the coatmaster will void any liability and annuls the guarantee.  
 
Put the coatmaster into operation at least once every six months. 
If the light source reaches 0% or after one year since the last service (also if the device is not in use) 
the coatmaster has to be serviced by a trained service engineer (see chapter 5.3.5). 
 
The Operating System software monitors the replacement parts of the coatmaster. As soon as the 
state of a replacement parts becomes critical or it has reached or exceeded its intended operating 
margin, a corresponging message is displayed (see chapter 5.3.4). 
 

7.2 Software maintenance 

With the coatmaster Web Client, the embedded software on the coatmaster and the corresponding 
coatmaster Operating System can be upgraded. In addition, it is possible to download log files for de-
tailed failure analysis. To proceed, connect the computer to the coatmaster (see chapter 4.3 and fol-
lowing). Use a web browser to access the coatmaster Web interface. 
 
Enter the IP address for the corresponding connection interface into the URL-line of the browse (see 
chapter 4.4.1). In the main menu of the coatmaster Web Client select Administrator. 
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Figure 51. Homepage in the web client  
 
To log in as administrator, use the User admin with password admin. 
 

7.2.1 coatmaster software diagnostics 

For trouble shooting the coatmaster AG support will sometimes ask you for the log files. To down-
load the log files from the coatmaster, select Diagnostics from the Administration page of the coat-
master Web Client. 

 
Figure 52. Downloading diagnostics in the web client 
 
Press the Downlaod logs (ZIP) to download the log file. Send the log file to coatmaster support. 
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7.2.2 coatmaster embedded software restore 

To undo a software upgrade it is possible to restore a previously installed version of the coatmaster 
embedded software. Select System restore from the Administration page of the coatmaster Web Cli-
ent. 

 
Figure 53. Restoring the system in the web client 
 
Choose the older software version and start the restore process. Restart the coatmaster after the re-
store and install the corresponding coatmaster Operating System (see chapter 4.4.2). 

7.3 Measurement window 

Clean the measurement window from any contamination by oil-free compressed air to assure good 
coatmaster performance and reliability. 
Stubborn contamination can be removed with the soft, lint-free cloth and alcohol (e.g. eyeglass 
cleaning cloth). 

7.4 Refill coolant 

 

 

 
NOTICE 

Risk of water within the coatmaster. The use of tab water as a coolant can lead to corrosion 
of component in contact with water. Use only de-ionized water. 

The coatmaster Coolant Refill Kit is not part of the coatmaster Inline scope of delivery. Please 
order separately if required.  
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Figure 54: Refill coolant into the CM Water Cooling unit 
 
For perfect operation of the coatmaster, the coolant of the cooling unit must be filled regularly. If 
coolant low-level warning or error is shown (refer to chapter 5.3.4) or if the coatmaster is delivered 
without coolant (when shipped at low temperatures), use the coatmaster Refill-Kit to refill coolant. 
The coolant consumption depends on the environmental conditions and the measuring frequency of 
the coatmaster. 
 
Refill / fill coolant:  
 
Step 1 : Do not connect fully discharged cooling unit with coatmaster. 
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Step 2: Open both screw caps. 
frontal view:   

  vent: aeration, apply angle tube  fill: apply funnel tube    

 
 
Open both screw caps using screwdriver Nr.5. 

 
 

Step 3: Connect angle tube (vent) und tube with funnel (Fill). 
Attention: only tighten by hand, do not use a wrench! 
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Step 4: Fill. 
Use deionized water (decalcified water) as the cooling liquid! 
Fill in water with the help of the funnel (total approx. 2l) until water is visible in the angled hose (vent-
ing) for the first time. The water level can withdraw in the case air bubbles are being removed. The 
cooling unit is then sufficiently filled. 

 
 
Step 5: Remove funnel with tube and angle tube. 
Attention: Some water may leak out! 
Close the connections again with the screwed caps.  
Attention: plastic threads, low force application is sufficient! 

 
 
Step 6: The cooling unit can now be connected to coatmaster and put into operation.   
If the tubes and the measuring head are emptied, they must first be filled with coolant as described in 
point seven.  
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Step 7: Fill tubes and head  
If the tubes and the measuring head are also emptied, these components must also be filled with 
coolant before commissioning. To do this, first fill the cooling unit with water as described. 
Now fill the tubes by connecting them individually to the cooling unit.  

 
Connect cooling unit electrically with coatmaster system. Do not connect the measuring head. 
The coatmaster is now switched on and the cooling unit starts to pump the water into the tube. 
Attention! The coolant level sinks very quickly. Add cooling water immediately or switch off the coat-
master before the minimum level is reached! After the level does not sink any further, let the coat-
master run for approx. 30s.  
 
If the water does not get into the tube, it may be that the water pump has air inside. The air usually 
disappears when the coatmaster is turned off for approximately 10 seconds. Make sure that the tubes 
are slightly higher than the cooling unit so that the air can escape from the pump. 
Refill the water tank and repeat the procedure for the second tube. 
After filling both tubes, refill the water tank and connect the tubes with the measurement head. Turn 
the coatmaster on again and repeat the procedure with the two tubes and the measuring head. If the 
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level of the coolant no longer decreases, turn the measuring head for approx. 30 s. in a position where 
the front lens points downwards. 
 
After filling the cooling unit, tubes and the measurement head let the full system run for 5 minutes. 
The system is now filled and the coatmaster can be shut down and properly put into operation. 
 

7.5 Filter pads 

7.5.1 coatmaster 

Visually inspect the filter pads regularly. When they are contaminated, they need cleaning. 
For this purpose, proceed as follows: 

• Unscrew the two screws on the rear of the device (see figure ). 

  
Figure 55: coatmaster – rear view. (6) Screws to access fileter pads 
 

• Remove the filter cover. 
• Take off the filter pads and clean them with compressed air. 
• If the filter pads are highly contaminated, they need to be replaced. 
• Remount the filter cover. 

7.5.2 coatmaster Inline 

If filter pads are installed within the rack, visually inspect them regularly. When they are contami-
nated, they need cleaning. For very strong contamination an exchange is necessary. 
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7.6 Blank measurement 

After service work the blank measurement must be repeated. This function is found in Preferences > 
device settings.  
 

 
Figure 56. Conducting blank measurement in the stand-alone software 
 
The values for Measurement duration, Light energy, SNR threshold and decim place are default val-
ues only. The default values can be corrected in the application settings.  

Measurement time (s): Default value for duration of the measurement 
Light energy (J): Default value for light source energy. 
SNR threshold (V): SNR (signal-to-noise) threshold for detecting invalid measurements. 
Decimal places (thickness): Default for desired amount of digits for the display of the thickness value 
Save raw data: Activate the checkbox to save raw data during the measurement (only for service 
purposes). 
 
NOTICE   
The coatmaster does not require the raw data for operation. We recommend deactivating this check-
box. 
 
Blank measurement: When clicking on the Start button, a window opens prompting to cover the IR-
lens and to start a blank measurement by clicking OK. Use a coatmaster AG blank cover to cover the 
IR lens before starting the blank measuremens. After placing the cover on the IR lens, press OK to 
start the blank measurements. This blank measurement serves as reference for later sample meas-
urements.  
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8 Troubleshooting 

If a software error occurs (error codes 1-14), restart the device. If the error persists, contact your ad-
ministrator and pass the error code.  

 

In case of hardware defect or malfunction (e.g. cooling liquid leak) proceed as follows: 
1. Disconnect the device from the control unit immediately. 
2. Inform the responsible person at the operating location about the fault. 
3. Repairs may be conducted by authorized personnel only! 
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9 Technical data 

9.1 Data sheet coatmaster 

 
 

 

 
 

coatmaster  
500 

 

 
 

coatmaster  
1000 

 

 
 

coatmaster  
1500 

 
 

coatmaster  
2000 

Energy 500 J 1000 J 1500 J 2000 J 
Measurement distance 5 cm – 15 cm ** 5 cm – 30 cm ** 5 cm – 40 cm ** 5 cm – 50 cm ** 
Measurement point Ø 2 – 20 mm * Ø 2 – 20 mm * Ø 2 – 20 mm * Ø 2 – 20 mm * 
Measurement range: 
Powder coating uncured 
Powder coating cured 
Pulverlack pre-cured 
Wet paint  

 
1-500 µm  

1-1000 µm 
1-1000 µm 
1-1000 µm 

 
1-500 µm  

1-1000 µm 
1-1000 µm 
1-1000 µm 

 
1-500 µm  

1-1000 µm 
1-1000 µm 
1-1000 µm 

 
1-500 µm  

1-1000 µm 
1-1000 µm 
1-1000 µm 

Measurement duration 20 ms – 2000 ms 20 ms – 2000 ms 20 ms – 2000 ms 20 ms – 2000 ms 
Repetition rate 1 Hz 0.5 Hz 0.4 Hz 0.3 Hz 
Relative velocity of sample 50 m/min 50 m/min 50 m/min 50 m/min  
Tilt tolerance ±70˚ ±70˚ ±70˚ ±70˚ 
Power connection IEC 320-C14 IEC 320-C14 IEC 320-C14 IEC 320-C14 
Supply voltage 230 V AC, 50 Hz 230 V AC, 50 Hz 230V AC, 50 Hz 230V AC, 50 Hz 
Fuse 10 A 10 A 10 A 10 A 
Power consumption max. 2000 W max. 2000 W max. 2000 W max. 2000 W 
Operating temperature 5°C – 35°C 5°C – 30°C 5°C – 30°C 5°C – 30°C 
Relative humidity < 80 % < 80 % < 80 % < 80 % 
Dimensions (mm) 374 x 490 x 196  374 x 490 x 196  374 x 490 x 196  374 x 490 x 196  
Weight 16.8 kg 16.8 kg 16.8 kg 16.8 kg 
Fixation Guide rail Guide rail Guide rail Guide rail 
Interface: 
Ethernet  
WLAN 
External sensor 

 
yes 

optional 
yes 

 
yes 

optional 
yes 

 
yes 

optional 
yes 

 
yes 

optional 
yes 

*  depending on distance / focal width 
**  depending on coating and substrate  
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9.2 Data sheet coatmaster Inline 

 

 

 
 

coatmaster  
Inline 500 

 
 

coatmaster  
Inline 1000 

 
 

coatmaster  
Inline 1500 

 
 

coatmaster  
Inline 2000 

Energy 500 J 1000 J 1500 J 2000 J 
Measurement distance 5 cm – 15 cm ** 5 cm – 30 cm ** 5 cm – 40 cm ** 5 cm – 50 cm ** 
Measurement point ø2 – 20 mm * Ø 2 – 20 mm * Ø 2 – 20 mm * Ø 2 – 20 mm * 
Measurement range: 
Powder coating uncured 
Powder coating cured 
Powder coating pre-cured 
Wet paint  

 
1-500 µm  

1-1000 µm 
1-1000 µm 
1-1000 µm 

 
1-500 µm  

1-1000 µm 
1-1000 µm 
1-1000 µm 

 
1-500 µm  

1-1000 µm 
1-1000 µm 
1-1000 µm 

 
1-500 µm  

1-1000 µm 
1-10000 µm 
1-1000 µm 

Measurement duration 20 ms – 2000 ms 20 ms – 2000 ms 20 ms – 2000 ms 20 ms – 2000 ms 
Repetition rate 1 Hz 0.5 Hz 0.4 Hz 0.3 Hz 
Relative velocity of sample 50 m/min * 50 m/min * 50 m/min * 50 m/min * 
Tilt tolerance ±70° ±70° ±70° ±70° 
Power connection IEC 320-C14 IEC 320-C14 IEC 320-C14 IEC 320-C14 
Supply voltage 230 V AC, 50 Hz 230 V AC, 50 Hz 230 V AC, 50 Hz 230 V AC, 50 Hz 
Fuse 10 A 10 A 10 A 10 A 
Power consumption max. 2000 W max. 2000 W max. 2000 W max. 2000 W 
Operating temperature measure-
ment head 

5°C –50°C 5°C –50°C 5°C –50°C 5°C –50°C 

Operating temperature cooling 
and generator unit 

5°C –35°C 5°C –35°C 5°C –35°C 5°C –35°C 

Relative humidity < 80% < 80% < 80% < 80% 
Dimensions measurement head 
(mm) 

204 x 254 x 268 204 x 254 x 268 204 x 254 x 268 204 x 254 x 268 

Dimensions cooling and genera-
tor unit 

483 x 133.35 x 418 
(19“ 3 HE)  

483 x 133.35 x 418 
(19“ 3 HE) 

483 x 133.35 x 418 
(19“ 3 HE) 

483 x 133.35 x 418 
(19“ 3 HE) 

Weight measurement head 5.3 kg 5.3 kg 5.3 kg 5.3 kg 
Weight cooling and generator 
unit 

17.5 kg 17.5 kg 17.5 kg 17.5 kg 

Fixation guide rail  guide rail  guide rail  guide rail  
Cable length between measure-
ment head and cooling and gen-
erator unit 

max. 10 m max. 10 m max. 10 m max. 10 m 

Height difference between 
measurement head and cooling 
and generator unit 

max. 5 m max. 5 m max. 5 m max. 5 m 

Interface: 
Ethernet  

 
yes 

 
Yes 

 
Yes 

 
yes 

*  depending on distance / focal width 
**  depending on coating and substrate 
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9.2.1 Dimension and assembly relevant information coatmaster 
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9.2.2 Dimension and assembly relevant information coatmaster Inline 
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10 Transport, packaging, storage 

10.1 Transport inspection 

The delivery must be checked for completeness and possible transit damage immediately at receipt.  
In case of externally visible damage, proceed as follows: 

• Do not accept the delivery or only under reserve.  
• Note extent of damages on the transportation documents or on the delivery note of the car-

rier.  
• File complaint. 

Claim any damage as soon as it is detected. Compensation claims can only be submitted within the 
applicable complaints periods. 

10.2 Packaging 

Dispose of packaging material in accordance with the respective valid laws and local regulations. En-
vironmental damage caused by incorrect waste disposal! Packing materials are valuable raw materi-
als and can continue to be used in many cases or sensibly reconditioned and recycled. 

• Dispose packaging material environmentally friendly. 
• Adhere to the valid local regulations for disposal. If necessary employ a special waste dis-

posal company to dispose of packing material. 

10.3 Storage 

Possibly, there are instructions on the packaging for storage that exceed the requirements men-
tioned here. These must be adhered to. 

Store packages under the following conditions: 
• Do not store outdoors 
• Store dry and dust-free 
• Do not expose to aggressive media 
• Protect agains solar radiation 
• Avoid mechanical shock and vibration 
• Storage temperature: 15 to 35 °C 
• Relative humidity: max. 60 % 

 
For storage exceeding 3 months: 
• Check the general condition of all parts and the packing regularly 
• As necessary, renew or replace the conservation 
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